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Team Design Tutorial

Tutorial Objectives

This tutorial provides an overview of the Team Design flow. In this tutorial, you will complete a
design acting as a team leader and various team members. The objective of this tutorial is to
familiarize you with partitions and the Team Design flow using the PlanAhead™ software.

The Team Design flow is a hierarchical design methodology that uses partitions to allow a large,
complex design to be broken up into smaller logical blocks.

e These blocks can be implemented independently and simultaneously.

e This allows each block to be individually designed, implemented, and verified in context with
the rest of the design.

e When all blocks are complete, the entire design is brought together in an assembly run in
which results can be imported and preserved.

A Team Design flow team consists of:
e One team leader

¢ One or more team members

Project Setup

Initially, as team leader, you will:

¢ Define partitions on each team member block. Each team member block is a black box.
e Define Pblocks.

e Review existing physical and timing constraints.

e Synthesize an initial version of the design using Xilinx® Synthesis Technology (XST)
incremental synthesis.

e Promote synthesis results for the Top partition.
e Run a Design Rules Check (DRC).
e Implement the initial design.

e Create PlanAhead projects for each team member.

Team Design Tutorial www.xilinx.com 5
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Team Member Work
When a PlanAhead project has been created for each team member, you will complete the work
of each team member as follows:
e Update the project to include actual design files for the team member block.
e Synthesize the updated team member design while importing the Top partition
Other team member blocks are black boxes.
e Implement the team member design.
Other team member blocks are black boxes.

e Promote successful synthesis and implementation results to a location accessible by the
team leader.

Design Assembly

The team leader then assembles the design by importing the results from each team member
project. You will:

e Assemble the design by importing the results from each team member project.

e Update the team leader project to include NGC files for each team member block.

e Set up implementation to import each team member block while implementing the Top
partition.

e Verify design assembles while maintaining placement and routing results from each team
member.

Tutorial Design Description

This tutorial uses an incremental synthesis flow to create separate netlist for each partitioned
instance. These individual netlists are required for a team design flow.

The design used throughout this tutorial contains:

e A RISC processor

o FFTs

e Gigabit transceivers

e Two USB port modules (to be partitioned)

e An xc7k70tfbg676 device

Team Design Tutorial www.xilinx.com 6
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Software Requirements

The PlanAhead tool is installed with ISE Design Suite software. Before starting the tutorial, be
sure that the PlanAhead tool is operational, and that the tutorial design data is installed.

For installation instructions and information, see the ISE Design Suite 14: Release Notes,
Installation, and Licensing (UG631).

Hardware Requirements

Xilinx recommends a minimum of 2 GB of RAM when using the PlanAhead tool on larger
devices. For this tutorial, a smaller design is used, and the number of designs open at one time
is limited. Although 1 GB is sufficient, it can impact performance.

Preparing the Tutorial Design Files

This tutorial uses a reference design, PlanAhead_Tutorial_TD.zip, which you can download
from the Xilinx PlanAhead Tutorials web page at:

http://www.xilinx.com/cgi-bin/docs/rdoc?v=14.5;t=planahead +tutorials

Extract the zip file contents into any write-accessible location. The extraction directory will be
referred to in this tutorial as <Extract_dir>.

RECOMMENDED: The tutorial sample design data is modified while performing this
tutorial. A new copy of the original PlanAhead_Tutorial data should be extracted each time
you run this tutorial

This tutorial includes a project file that has already been implemented. To reduce the data size,
some implementation files were removed from the design, leaving only the required results data
in the run directories.

Team Design Tutorial www.xilinx.com 7
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Lab 1: Team Design

Step 1: Opening a Project and Setting Partitions

The PlanAhead design tool enables you to create several project types depending on where in
the design flow the tool is being used. RTL sources can be used to create a project for
development and analysis, synthesis, implementation, and bit file creation.

This tutorial uses an existing PlanAhead tool project, and focuses on the team design aspects in
the software. You will not create a new design using the New Project wizard.

Opening the PlanAhead RTL Project

To open the PlanAhead RTL project:
1. Open the PlanAhead tool.
¢ On Windows, select the Xilinx PlanAhead Desktop icon, or select:

Start > All Programs > Xilinx Design Tools > ISE Design Suite 14.5 > PlanAhead >
PlanAhead.

e OnLinux, go to the <Extract Dir> directory and type: planAhead.

2. From the Getting Started page, click Open Project.

3. Browse to <Extract Dir> and open the project file located at:
./Projects/project TL/project TL.ppr

The Project Manager view opens. You can view the design source files in the Hierarchy tab of
the Sources view. These files include:

e VHDL and Verilog files

e A User Constraint File (UCF) named top full.uct. The UCF contains timing constraints
and I/O pin locations.

Opening the Elaborated Design

Use the Elaborated Design view to define partitions in an RTL project. When the Elaborated
Design view is opened:

e The RTL code is elaborated.

e The design hierarchy is displayed.

This is a pre-synthesized view of the design that is used to define partitions and create
constraints. To open the Elaborated Design view:

1. In the Flow Navigator, click Open Elaborated Design.

Team Design Tutorial www.xilinx.com 8
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When you open the elaborated design, the PlanAhead tool opens a Critical Messages dialog
box, warning you that the tool is unable to resolve certain cells or nets related to the
cpuEngine and the usbEngine modules. These are black box cells which you will soon be
defining as partitions.

2. Click OK to close the Critical Messages dialog box.

E Critical Messages @

! . There were 4 critical warning messages while opening this design.

Messages

(@) [EDIF 20-96] Could nat resolve non-primitive black box cell'or 1200_top' instantiated as 'cpuEngine’ [C:
[Data/Planahead_Tutorial_TD/Projects/project_TL/project_TL.srcs/sources_1fimports fhdlftop.v:324]
Resolution; File names need to match cell names: an EDIF definition will be found in or 1200_top.edf; an
HEOL definition may be placed in any Verilog/VHOL file.

(@) [EDIF 20-96] Could nat resolve non-primitive black box cell 'ushf_top' instantiated as ‘ushEngined’ [C:
[Data/PlanAhead_Tutorial_TD/Projects/project_TL/project_TL.srcsfsources_ 1fimports fhdl/ftop,v:433]
Resolution: File names need to match cell names: an EDIF definition will be found in usbf_top.edf; an HOL
definition may be placed in any Verilog/VHDL file.

(@ [Constraints 18-11] Could not find net ‘cpuEngine for 1200_cpuj/or 1200_aluf* [C:
[Data/Planahead_Tutorial_TD/Projects/project_TL/project_TL.sres/constrs_1fimports/Sources/top_full.ucf:7]

(@ [Constraints 18-324] No definition for group 'GRP_ALU_DATAOQUT', timing constraint is ignored [C:
[Data/PlanAhead_Tutorial_TD/Projects/project_TL/project_TL.srcs/constrs_1fimports/Sources/top_full, ucf:8]

Dion't show this dialog agaire

| OK || Open Messages View

Figure 1: Critical Messages — Black Box Cells

The two usbEngine modules and the cpuEngine module are good candidates for partitioning
for the following reasons.

e They are logically isolated from one another and do not benefit from optimizations with
other blocks.

e They are timing critical blocks that can be developed independently and are beneficial to
preserve once implemented.

e The interface timing in and out of these blocks are not critical as they are registered.

You can use the PlanAhead design rule checks to help identify modules that are good
candidates for partitions.

You can floorplan partitioned instances just like any other instance. Creating Pblock
(AREA_GROUP) constraints can help achieve timing closure and improve runtime.

The steps below show you how to set partitions and create appropriate Pblock constraints for
the team member instances. Pblocks are required in a Team Design flow for each team member
partition.

Team Design Tutorial www.xilinx.com 9
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Step 2: Drawing Pblocks for the Team Member Partitions

Setting Partitions on Team Member Instances

To set partitions on team member instances:
1. From the Elaborated Design view, click the RTL Netlist tab.
2. Press Ctrl and select:

e usbEngine0

e usbEnginel

e cpuEngine

Elaborated Design - xc7k70tfbg676-2 (active)
RTL Metlist - 0O

= [E]
G2 top
©= = Nets (920)
©= = Primitives (12)
© clkgen iclock generator)
El cpuEngine (or’
@= [4] fitEngine (fftTy )
o= [@ mgtEngine (mq = CORY Text Ctri+C
El ushEngined (u % Export Statistics...
B ushEnginel (u
©= [T wharbEngine {

0y
X

& Instance Properties...  Ctri+E

[ Draw Phlock
MNew Pblock...

Set Partition %

1] Select Primitives Ctri+shift+5

&b Sources [ R

Figure 2: Set Partition

3. Right-click to open the popup menu, and select Set Partition.

Although three partitions are defined here, there are only two team members in addition to the
team leader. Both usbEngine instances are managed by a single team member because there is
only one set of Hardware Description Language (HDL) code associated with this module.

Step 2: Drawing Pblocks for the Team Member
Partitions

In this step, you:
e Define Pblocks.
e Review existing physical and timing constraints.

This step does not affect synthesis results. You could perform it post-synthesis in the
Synthesized Design view instead.

Team Design Tutorial www.xilinx.com 10
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Step 2: Drawing Pblocks for the Team Member Partitions

For more information on defining Pblocks refer to the Floorplanning Methodology Guide (UG633)
and the Design Analysis and Floorplanning Tutorial: PlanAhead Design Tools (UG676).

To draw Pblocks for the team member partitions:

1. Change the layout to be Floorplanning by selecting Layout > Floorplanning.
2. From the RTL Netlist window, select usbEnginel.

3. Right-click and select Draw Pblock.

Elaborated Design * - xc7k70tfhgs76-2 (active)

Physical Constraints — O o ¥  RTL Netlist — O g %
Q T =[F = S[E]

FErtl 1 [G* top

L @ ROOT &~ [ Nets (920)

@~ = Primitives (12)

® clkgen iclock generator)
[ cpuEngine (orl200 top)

©- [4] fitEngine (fftTop!)

© mgtEngine (rmgtTop)
[ ushEngined (ushf top)
[ usbEnginel (usbf top)

o [@wh 5 jnstance Properties...  ctre

[ Copy Tent Ctrl+c
(% Export Statistics...
¥ fssign. .

Instance Properties - 0O g x __;Enass;grl'l v
= Draw PR

b (L] [ E;
+ Mew Phlock...

Figure 3: Selecting the Draw Pblock Tool

4. With the Draw Pblock tool active, move the cursor to the Device window.

5. Click the top-left corner of the device where the CLBs start, and drag down and to the right
to create a rectangle covering most of the top-left quadrant, as seen in Figure 3 .

Team Design Tutorial www.xilinx.com 11
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Step 2: Drawing Pblocks for the Team Member Partitions

Elaborated Design * - xc7k70tfbg676-3 (active) x

RTL Netlist [ T I Project Summary X | #2] RTL Schematic X | § Device X O x
= A&

5t top

-5 Nets (320)
+ Primitives (12)
+-{H] dkgen {cloc
i cpuEngine
+-{3] fftEngine (f
: mgtEngine (matTop)
{1 usbEngined (usbf_top)

+! whbArbEngine (wb_conmax_top(dw=32 @ New Pblock

Mame: |pblock_usbEngine1
Grids
7] SLICE (2400)

4 L] DSP43 (30)
& Sources™. (52 RTL Netlist

Instance Properties

o 7] RAME36 (40)
o3| L
2|

L1 usbEnginel

/| Assign selected instance

MName: usbEngine1
Cell: usbf_top
Type: Black Box
Mumber of instance pins: 166
MNumber of nets: 166

General | Attributes | Statistics | Instance Pins | Children | Nets | Partition

Figure 4: Pblock Rectangle for usbEnginel

7. In the New Pblock dialog box:

e Verify that the SLICE and RAMB36 grids are selected.

e Deselect other resources that are not needed.

e Verify that the number of available RAMB36 is 40.

If the Pblock rectangle does not include sufficient resources, the design may fail to place.
8. Click OK.

9. If the numbers of available resources are different than shown, adjust the size of the Pblock
rectangle by selecting it and resizing it until it contains:

e SLICE (2400)
o RAMB36 (40)

10. Repeat the steps above for usbEngine0 in the bottom-left quadrant.
Only SLICE and RAMB36 (40 of them) are required for this block.
11. Repeat the steps above for cpuEngine in the bottom-right quadrant.

For cpuEngine, the Pblock contains all four ranges, as seen in Figure 4, or may be defined as
clock regions X1YO to X1Y1:

Team Design Tutorial www.xilinx.com 12
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[ New Pblock =

MName: |pblock_cpuEngine
Grids

CLOCKREGION_X1Y0:CLOCKREGION X1¥1

7] SLICE (2500)
7] D5P48 (40)
7| RAMB18 (30)

7] RAMB36 (40)

| Assign selected instance

[ OK ] | Cancel

Figure 5: New Pblock Resources

i
O
:
g
E

"ﬂ-l ock_usbEnginel

Figure 6: Completed Floorplan for Pblocks usbEngine0, usbEnginel, and cpuEngine

Team Design Tutorial www.xilinx.com 13
UG839 (v14.5) April 25, 2013



b
i. X"—lNX Step 3: Synthesizing and Implementing the Design

Step 3: Synthesizing and Implementing the Design

In the previous steps, you:

e Defined partitions on the elaborated HDL design.
e Created Pblock constraints.

In this step, you will:

e Run synthesis.

e Run DRC.

e Run implementation.

During synthesis, XST recognizes that the design has partitions, and runs the design through an
incremental flow.

In this flow XST generates individual NGC files for each partition. In this design the top partition
contains all logic in top.v, as well as all logic from hierarchical blocks that are not their own
partition (fftEngine, mgtEngine, and wbArbEngine). All of logic from the top partition will be
synthesized to “"top.ngc”. Since the instances usbEngine0, usbEnginel, and cpuEngine are
black boxes and contain no logic in this initial project, no NGC files will be generated for these
partitions.

This tutorial uses an RTL project. For a bottom-up or third-party incremental synthesis flow:
e Run synthesis outside the PlanAhead tool.

e Use a netlist project instead of an RTL project in the PlanAhead tool.

Running Synthesis

This design uses default synthesis options. To run synthesis:
1. In the Flow Navigator, click Run Synthesis, as seen in Figure 6.

2. Before running synthesis, PlanAhead must save all your constraints for the partition and
floorplan changes. If prompted to save your design, click Save.

3. After synthesis completes a Synthesis Completed dialog box will appear.

4. Choose to Open Synthesized Design, and click OK to open the Synthesized Design in the
next step.

This loads the synthesis results and allows for additional DRC checking.

Note: You will be prompted to close the Elaborated Design. You will need it open later, so to
save time, you should select No.

5. Click OK to close the Undefined Modules dialog box, and again to close the Critical
Messages dialog box. It is expected to have black boxes in the design at this point.

Team Design Tutorial www.xilinx.com 14
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Flow Navigator Lid

My o pn
Qe ==

» Project Manager

4 RTL Analysis
4 Elaborated Design
(D ReportDRC

] schematic

4 Synthesis
@ Synthesis Settings
$- Run Synthesis

Step 3: Synthesizing and Implementing the Design

Elaborated Design * - xc7k70tthga7a-3 (active)
RTL Netlist =

A fer
i

- usbEnginen (Lsbf_tof
[l usbEngine1 (ushf_top]
+-{@] whArbEngine (wb_conmax_top{dw=32,aw=32,rf_addr=4b

-] ey T
B Open Synthesi Run Synthesis

Run synthesis on your project source files,

4 Implementation

@ Implementation Settings

Figure 7: Run Synthesis

Running DRC on Partitions

You can run Design Rule Checks (DRC) on the Elaborated Design, although the checks at this
stage are limited. Xilinx recommends that you run a DRC on the post-synthesis design before

implementation.

With the synthesized design open, to check DRC, run partition-specific DRCs.

1.

In the Flow Navigator under Synthesized Design, click Report DRC.

2. From the Report DRC dialog box, deselect all rules except Partition and Team Design.

3. Click OK.

Team Design Tutorial
UG839 (v14.5) April 25, 2013
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DRC Messages

The PlanAhead tool can report the following message types for the DRC rules:

e Advisory
e Warning
e Error
e Fatal

In this case, the DRC returns several warning messages. You can safely ignore them. The DRC

Step 3: Synthesizing and Implementing the Design

[@] Repert DRC M5
Results name: |drc_1
Output file: E]
Rule dedk: all hd

Rules to Check: 13 of 1347

o ey A
b N — .

=& Al Rules (1347
G- Netlist (1208]
(-1 Bank (33)
--D Flow (1)

[0 DSP48 (4]

(-1 Implementation (3)
--D Floorplan ()
G- 108 (39)

(- Partition {10
--D Placer (32

([0 RAMB (1)

(-l Team Design (3]

SelectAll || Clear Al |

Open in a new tab

’ oK ][ Cancel ]

Figure 8: Run Partition Design Rule Checks

messages are caused by the black boxes in the design.

Note: In an actual design, investigate all DRC messages, and correct any serious issues.

Team Design Tutorial
UG839 (v14.5) April 25, 2013
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Step 3: Synthesizing and Implementing the Design

Running Implementation

Before transmitting the design to each team member, the team leader should run

implementation to check that all timing and floorplan constraints are valid. Since the usbEngine
modules and cpuEngine modules are black boxes, the implementation results will not be of any
other value at this point.

1.

v o~ wN

Team Design Tutorial

In the Flow Navigator, click Run Implementation.

As implementation is running, click the Report tab to see a list of all implementation reports.

As each process finishes, the related reports are available for review.

After NGDBuild finishes, double-click the NGDBuild Report to open the report.

Scroll to the bottom of the report file to review the partition information, as seen in Figure 7.

L Project Sumnmary & Device £ NGDBuild Report - impl_1 =
110 (=]
111 Partition Implementation Status
112
113

~ 114  Preserved Partitions:

e 115

= 115

. |117  Implemented Partitions:

i|118
119 Partition "/top":
120 Attribute STATE set to IMPLEMENT.
121
122 Partition "/top/cpuEngine” (Black Box Module}:
123 attribute STATE set to IMPLEMEMT.

o | 124

= (125 Partition "stopfusbEngined@" (Black Box Module]:

& 126 attribute STATE set to IMPLEMENT.

o127

Y ol12s Partition "/top/usbEnginel" (Black Box Modulel:
120 Attribute STATE set to IMPLEMENT.

= (130

Sl |

¥ (132
133 NGDBUILD Design Results Summary:

134  Number of errors: o

135 Mumber of warnings: 18

135

137 Total memory usage 1s 558100 kilobytes

133

138Writing NGD file “"top.ngd" ...

140Total REAL time to NGDBUILD completion: S5 sec
141 Total CPU time to WGDBUILD completion: 27 sec
142

143Writing MGDBUILD log file “top.bld"...

144 (=]

Figure 9: Partition Implementation Status in Report Files

The three team member partitions are all listed as Black Box Module. Partition information is

provided in every report file (NGDBuild, Map, and PAR). This allows you to easily verify the

status of all partitions on a given run.

In the Implementation Completed dialog box, select Promote Partitions, and click OK.

The Promote Partitions dialog box opens as seen in Figure 8.

UG839 (v14.5) April 25, 2013
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Step 4: Promoting Synthesis and Creating Team
Member Projects

The design is now ready for the team members to start their work.

e Before generating PlanAhead projects for each team member, promote the initial synthesis
results.

e Because the implementation results of the previous step are not used by team members, the
implementation results do not need to be promoted.

Promoting Successful Synthesis Results

To promote the successful synthesis results after synthesis (or implementation) has completed:

1. Click Promote Partition in the Flow Navigator (located under Implementation), if the
Promote Partitions dialog box is not already open.

2. In the Promote Partitions dialog box, select the top partition in the synth_1 run to be
promoted.

E Promote Partitions @

i | Please select entire runs or spedific partitions to be promoted. This copies the partitions in implemented run
¥ to the specified promote directory, After promoting runs, you can impert the partitions into runs,
Select Partitions to promote

el =—]
pég &=

Run Directory Description
=I-[v synth_1 1Ahead_Tutorial_TD/Promote/top/synth_1 D

-l top

- [ cpuEngine

[ usbEngine0

-] usbEngine1

=[] impl_1 ts/project_TL/project_TL.promote,Ximpl_1 D
[ top

[ cpuEngine

[ usbEnginen

[ usbEngine1

4 M 3 @

Select Implemented || Clear All |

/| Automatically manage Partition action and import location

Gl

Figure 10: Promote Partitions Dialog Box

Do not to promote other partitions at this stage. No useful data exists for the other
partitions. Promoting them will require additional steps by each team member to change the
promoted partition state values back to implement for their runs.
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8.

Set the Directory for the synth_1 run to:
<Extract Dir>/Promote/top/synth 1

The default Directory setting could be used, but since this promoted synthesis data will be
accessed by multiple team members it is more effective to promote the data to a location
outside of the project directory.

Enter an optional description about the promoted data.
Verify that Automatically Manage Partition Action and Import Location is checked.

Checking this option enables the PlanAhead tool to update the partition state and import
directory for the next synthesis run, whether by the team leader or by a team member. If this
box is not checked, the team leader must manage these attributes.

Click OK to promote the top partition synthesis results.
The Promoted Partitions view now appears, as seen in Figure 9.

You can open this view using the Window > Promoted Partitions command from the main
menu. You can close it by clicking on the Close Window icon. ' *

Promoted Partitions. — O w» X

Promoted Directory  Run Promoted on Description

synth_1[4/24/13 12:13 PM|This is the topJevel synthesis. .
..... [ top

g m b @

4% Sources | (] Netlist '+ Promoted Partitions

Figure 11: Promoted Partitions

In the Flow Navigator, under Project Manager, select the Specify Partitions command to
open the Specify Partitions dialog box, as shown in Figure 10.

The Specify Partitions dialog box shows in the Action column that the top partition will be
imported from the location specified in the Import From column. The Specify Partitions
dialog box lets you choose the appropriate action for the different partitions used in the
design. You can choose to import a partition that has been previously synthesized or
implemented, or re-implement the partition in the context of the design. You will examine
this topic in greater detail later in this tutorial.

9. Click Cancel to close the Specify Partitions dialog box.
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Creating Team Member Projects for usbEngine and cpuEngine

E Specify Partitions @
[0] Spedify whether partitions will be imported or implemented
Synthesis | Implementation
Mame Action Import from Preservation
O+ top Import « | Data/PlanAhead _Tutorial_TD/Promote/top synth_1 |_|| Routing -
& cpuEngine  Implement » MN/A
[ usbEngined Implement » MN/A
[ usbEnginel Implement » MJA
1 I} } @I
’ oK ] | Cancel |

Figure 12: Specify Partitions

Step 4: Promoting Synthesis and Creating Team Member Projects

To create a consistent starting point for all team members, create multiple copies of the current
project. For this tutorial, you will create two copies:

One project for the cpuEngine partition,

One project for the usbEngine partitions.

The usbEngine instances are copies of a single module, and will be managed by a single

team member.

To create team member projects for usbEngine and cpuEngine:

1. Select File > Save Project As.

E Save Project As

;0" Save this project to a new name and location.

Mame and Location

Project name: project_TM_ustngine|
Project location: | C:/Data/PlanAhead_Tutorial_TD/Tutorial_Created_Data

/| Create project subdirectory
Project will be created at: Ci/... [Tutorial_Created_Data/project_TM_usbEngine

Figure 13: Save Project As

Team Design Tutorial www.xilinx.com
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2. Enter project_TM_usbEngine as the Project Name

3. Specify the following as the Project location:

<Extract Dir>/Tutorial Created Data
4. Verify Create Project Subdirectory is checked.
5. Click OK.
6. Repeat 1 through 5 above, with the following parameters:
e Project Name: project_TM_cpuEngine
e Project location: <Extract Dir>/Tutorial Created Data
At this time, you should have three projects for the design team to work from:

e <Extract_Dir>/Projects/project_TL: The original top-level design project created by the team
lead.

e <Extract_Dir>/Tutorial_Created_Data/project_TM_usbEngine: The project to be used by the
team member working on the two usbEngine partitions.

e <Extract_Dir>/Tutorial_Created_Data/project_TM_cpuEngine: The project to be used by the
team member working on the cpuEngine partition.

In addition, you have created the synthesis data for the top-level partition, and stored it in a
separate partition repository, under <Extract_Dir>/Promote.

In the next step of the tutorial you will switch roles, to change from team leader to the designer
of the cpuEngine partition.
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Step 5: Working on cpuEngine as Team Member

Acting as the team leader in the previous steps, you:

e Set up the design.

e Created a workspace for each team member.

You will now switch roles and implement each block as a team member.

While the work of the team members is usually done in parallel, for this tutorial each team
member block is handled sequentially.

For each team member project, you will:

e Update the project sources to include the completed logic for the team member block.
e Synthesize the project.

e Implement the project.

e Promote the results.

Adding Sources to cpuEngine

Begin by adding the design sources to the cpuEngine project since it is already open from the
last step. Make sure that the current PlanAhead project is project_TM_cpuEngine. If it is not,
open this project now.

To add sources to cpuEngine:
1. Switch to the Project Manager view by click on Project Manager in the Flow Navigator.

2. In the Sources window, use the Hierarchy tab to expand top and select cpuEngine
(or1200 bb.v).

This is the black box module for cpuEngine that was used for the initial project. You will now
replace this black box module with logic.

3. Right-click, and select Remove File from Project.
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M A i X
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Messages: () 1 critical warning

Step 5: Working on cpuEngine as Team Member

=& Design Sources (5)
[ Verilog (2)
| Verilog Header (2)
-l top (top.v) (7)

# dkoen - dock_generator |
' matEnaine - mgtTop (m
| fitEngine - fitTop (FT

) usbEnginel - usbf_top (usb

) usbEnginel - usbf_top (usb

oo Pl i

puEngine - or 1200_top (or 1200
bArbEngine - wb_conmax_top |
f_bb.

f_bb.

Hierarchy | Libraries | Compile Order

£ Sources | 7 Templates

Source Node Properties

—_ O = £ Project Summar
= &3 Project Set
g
- Project name:
i Product family:
Project part:
& Source Mode Properties... Ctrl+E
*  Open File Alt+0
Go To Instantiation F7
Replace File...
Alt+1
*  Remove File from Project... Delete
Alt+Equals
Disable File Alt+Minus

Figure 14: Remove or1200_bb.v Black Box Module

The Remove Sources dialog box opens.

4. Click OK.

© o N o wu

E Remove Sources

=l

:] CK to remove the 1 selected file from the project?

[ Also delete the project local file/directory from disk

’ oK ] [ Cancel

)

Figure 15: Remove from Project

Browse to the following location:

<Extract Dir>/Sources/hdl/.

10. Select the or1200 directory.

11. Click Select.

Team Design Tutorial
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At the top of the Sources window, click the Add Sources icon. ©-
From the Add Sources wizard, select Add or Create Design Sources.
Click Next.

Click Add Directories to add the completed sources for the cpuEngine instance.
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E Add Sources
Add or Create Design Sources

new source file on disk and add it to your project.

Specify HOL and netlist files, or directories containing HOL and netlist files, to add to your project. Create a f

sl

<

Id Mame Library Location
Bl or1200 work o C:\Data‘PlanAhead_Tutorial_TD\Sourcesihdl

Add Files... ] | Add Directories... ’ Create File...

[7] Scan and add RTL indude files into praject
Copy sources into project
Add sources from subdirectories

Next = [ Finish

] [ Cancel

Figure 16: Add Source Directories — or1200

12. Verify the directory to be added.
13. Click Finish.

14. In the Hierarchy tab of the Sources view, you should see the cpuEngine module can now be

expanded.

Team Design Tutorial www.xilinx.com
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Synthesizing and Implementing cpuEngine

The Elaborated Design and Synthesized Design views are now out of date. To update them, you
will:

Reload (or close and reopen) these views.
Verify the partition settings for synthesis and implementation.
Launch the runs.

Promote the results.

To reload the design:

1

If the Elaborated Design view was closed, click Open Elaborated Design in the Flow
Navigator to load the latest version of the design.

If the Elaborated Design view is open, the banner across the top states that the view is out of
date. Click Reload to reload the view.

Elaborated Design - xc7k70tfhg676-2 (active)

() Elaborated Design is out-of-date. Design sources were modified, more info Reload

Figure 17: Design Out-of-Date

Click OK to clear the Critical Message dialog box.

In the Netlist view, verify that cpuEngine is no longer a black box, and also note that the two
usbEngine instances remain black boxes in the current project.

In the Flow Navigator, under Project manager, click Specify Partitions.
In the Specify Partitions dialog box, from the Synthesis tab, verify that:
a) Top is set to Import.

b) All other partitions are set to Implement.

At this point, there is no other data to import besides the top-level synthesis results
provided by the team leader. Top is the only partition that has been promoted.

If Top is not set to import for synthesis, either of the following might have occurred:
e Top was not promoted correctly.

e Automatically Manage Partition Action and Import Location was not checked in the
Promote Partition dialog box.

If Top was not correctly promoted, it cannot be imported now. You must return to Step 4:
Promoting Synthesis and Creating Team Member Projects, to promote the top partition.
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m Specify Partitions

Synthesis | Implementation

,'o', Specify whether partitions will be imported or implemented

==

&% cpuEngine  Implement » MjA
& usbEngine0 Implement » MjJA
& usbEnginel Implemeni » MjA

Name Action Import from

+ top Import = |C:/Data/PlanAhead_Tutorial_TD/Promoteftopfsynth_1

Preservation

I:I Routing -

| OK. | | Cancel

Figure 18: Specify Partitions Dialog Box

7. Click the Implementation tab to verify that all partitions are set to Implement.

8. Click OK to close the Specify Partitions dialog box.

Note: To save time, instead of running synthesis and implementation in the following sequence,
open the completed project at: <Extract_Dir>/Projects/project_TM_cpuEngine_completed. When
the project is open, from the Flow Navigator select Open Implemented Design.

9. In the Flow Navigator, click Run Implementation to synthesize and implement the design.

10. If prompted, click Yes to launch synthesis prior to implementation.

11. In the Implementation Completed dialog box, select Open Implemented Design.

12. If prompted, click No to not close the Elaborated Design.

13. Click OK to any Undefined Modules Found or Critical Messages dialog boxes. These are

expected messages.

Verifying and Promoting Results of cpuEngine

With the Implemented Design open, the Device view shows that:

e The Pblock for cpuEngine is relatively full.

e The two Pblocks for the usbEngine modules are relatively empty.

Because the usbEngine instances were black boxes, no logic exists for these two blocks in
the implemented design. Logic elements belonging to the top partition is placed in the
usbEngine Pblocks because it was not restricted from being placed there.

The Highlight Primitives command, in the popup menu of the Device view, can be used to
create a highlighted view as shown in the following figure.

Team Design Tutorial
UG839 (v14.5) April 25, 2013

www.xilinx.com 26



& XILINX.

Step 5: Working on cpuEngine as Team Member

Implemented Design - xc7k70tfbge76-3 (active) b4

Metist _Ovwr = T Project Summary X | G Device X O e =
= 7rl|[E

3] top

+-15 Mets (1022]
-5 Primitives (153)
+-{d] dkgen {clock_
+-{#] cpuEngine
+-{d] fftEngine (fftT
+-{1] matEngine (m
@] usbEngine0 (L
i[] usbEngine1 (usb
+-{1] iwhArbEngine

& Sources™. )] Netlist

Instance Properties — O x
& = Bk
wharbEngine

MName: whbArbEngine

Cell: wh_conmax_top

Type: Others

Mumber of instance pins: 2570
MNumber of nets: 1543

General | Attributes | Statistics | Instance Pins | Chile 4 » B

Figure 19: Implemented Design - cpuEngine

4. To verify that timing has been met, review any of the following:
e The Timing Score in the Design Runs view
e The details of the Timing Results window
e The Timing Score in the Project Summary window

5. In the Flow Navigator, click Promote Partitions to promote the successful synthesis and
implementation results.

Note: If the Elaborated Design view is not opened, you are prompted to open it.
6. Select only the cpuEngine instance in both the synthesis and implementation runs.
7. Set the Promote directories.

e synth 1: <Extract Dir>/Promote/cpuEngine/synth 1

e impl 1: <Extract Dir>/Promote/cpuEngine/impl 1

The Promote directory used in team design should be a network location or repository that
is accessible by all team members. This tutorial changes the default promote location to a
folder outside the project directory structure to emulate such a location.
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E Promote Partitions @

,'0] Flease select entire runs or specific partitions to be promoted. This copies the partitions in implemented run to the specified promote directory.
P After promoting runs, you can impart the partitions into runs.
Select Partitions to promote

e
=

Run Directory Description

= [ synth_1 C:/Data/PlanAhead_Tutorial_TD/Promote/cpuEngine/synth_1 D Synthesis results for cpuEngine
| Ll tp

- vl cpuEngine

[ usbEngined

. +~[d usbEngine1

=n v impl_1 C:/Data/PlanAhead_Tutorial_TD/Promote/cpuEngine fimpl_1 D Implementation results for cpuEngine
[ top

¥ cpuEngine

- [ usbEnginen

[ usbEngine1

] T 3 @

Select Implemented || Clear all

Automatically manage Partition action and import locatior

Figure 20: Promote cpuEngine

8. Uncheck Automatically Manage Partition Action and Import Location.

While disabling Automatically Manage Partition Action and Import Location is not
critical to this tutorial, Xilinx recommends removing it for team members in a team design
flow.

The cpuEngine team member might continue working on this block. Removing this option
prevents the software from automatically importing an updated cpuEngine partition on the
next run. This way the promoted partition results can be imported by the Team Leader as
needed or as appropriate, rather than every time the cpuEngine designer makes a change.

9. Click OK to promote the partitions.
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Step 6: Working on usbEngine as Team Member

In this Step, you will repeat the procedures of Step 5 as a team member working on usbEngine.

If multiple processors are available, you can perform this step in parallel while the cpuEngine
project is implementing.

Adding Sources to usbEngine

To add sources to usbEngine:
1. Close the current open project unless:
e You are doing this step in parallel, and
e The cpuEngine has not yet finished implementation, or has not been promoted.

2. Open the PlanAhead project:
<Extract Dir>/Tutorial Created Data/project TM usbEngine

3. Click the Project Manager view.

4. In the Sources view, use the Hierarchy tab to expand top and select one of the two
usbEngine  instances (usbf bb.v).

This black box module definition is used for the two usbEngine instances in the initial
project. It will now be replaced with logic.

5. Right-click to open the popup menu and select Remove File from Project.

6. Click OK in the Remove Sources dialog box.

Project Manager - project_TM_usbEngine

Sources — O o =

QT2 at B
@[5 Design Sources (5)
| Werilog (20
| Verilog Header (2)
gy top (topawl (7]
@ clkgen - clock_generator (clock_generator.)
@ mgtEngine - mgtTop (mgtTop.v) (23]
@ fftEngine - fftTop (ftTop.w (1)
@@ cpuEngine - orl200_top (orl200_bb.w)
W@ whirbEngine - wh_conmar top (wh_conmas topy) (250
@ ushEngined - ushf top (usbf bb.w
i ushEnging & Source Mode Properties,.,  CtriHE

o~ = Constraints (1) [ Copy Text e
* Open File Ak+O
Update File Contents... Ak

A Remove File from Project...  Delete

Hierarchy Libraries
Disable File Alt+Minus

Oooo o i o s

& Sources ¢ T

Figure 21: Remove Black Box Module usbf_bb.v
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8. At the top of the Sources window, click the Add Sources icon. &

9. From the Add Sources wizard, select Add or Create Design Sources.
10. Select Next.

11. Click Add Directories.

12. Browse to: <Extract Dir>/Sources/hdl/

13. Select the usbf directory to add the completed sources for the usbEngine instance.
14. Click Select.

15. Click Add Files

16. Select the file: <Extract Dir>/Sources/hdl/rtlRam.v

17. Verify the file and directory to be added.

18. Click Finish.

E Add Sources @
Add or Create Design Sources
Spedfy HOL and netlist files, or directories containing HDL and netlist files, to add to your project. (gﬂ
Create a new source file on disk and add it to your project. ¢
Id MName Lbrary Location
1 usbf C:\Dam‘l,PlanAhead_TubJriaI_TD‘.,Sources‘lhdl
w2 riRam.v work . C:\Data'PlanAhead_Tutorial_TD\Sourcesihdl .

i Add Files. .. d ’ Add Directories. .. ] ’ Create File...

[] Scan and add RTL indude files into project
Copy sources into project
Add sources from subdirectories

Mext = [ Einish ] [ Cancel

Figure 22: Add Sources - usbEngine
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Synthesizing and Implementing usbEngine

To synthesize and implement usbEngine:

1
2.
3.

6.
7.

In the Flow Navigator, click Open Elaborated Design to open the Elaborated Design view.
Click OK to close the Critical Messages dialog box.

Verify that the two usbEngine instances are no longer black boxes.

Notice that in this version of the design, the cpuEngine is still a black box.

In the Flow Navigator, under Project Manager, click Specify Partitions.

From the Synthesis tab, verify that:

a) Top is set to Import.

b) All other partitions are set to Implement.

There is no other data to import besides the top-level synthesis results. Top is the only
partition that has been promoted.

If Top is not set to import for synthesis, either of the following might have occurred:
e Top was not promoted correctly.

e Automatically Manage Partition Action and Import Location was not checked in the
Promote Partition dialog box.

If Top was not correctly promoted, it cannot be imported now. You must start over at Step 4:
Promoting Synthesis and Creating Team Member Projects, or earlier.

Click the Implementation tab to verify that all partitions are set to Implement.

Click OK to exit the Specify Partitions dialog box.

Note: To save time, instead of running synthesis and implementation in the following sequence,
open the completed project at: <Extract_Dir>/Projects/project_TM_usbEngine_completed.
When the project is open, from the Flow Navigator select Open Implemented Design.

8.
9.

In the Flow Navigator, click Run Implementation to synthesize and implement the design.

If prompted, click Yes to launch synthesis prior to implementation.

10. In the Implementation Completed dialog box, select Open Implemented Design.

11. Click No, if prompted to close the Elaborated Design.

12. Click OK to any Undefined Modules Found or Critical Messages dialog boxes. These are
expected messages.
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Verifying and Promoting Results of usbEngine

With the Implemented Design open, the Device view shows that:
e The Pblocks for usbEngine0 and usbEnginel are relatively full.
e The Pblock for the cpuEngine instance is relatively empty.

Because the cpuEngine instance was a black box, it is expected to be empty. However, some
logic can be seen in this region. The logic from the top level partition was not restricted from
being placed inside the cpuEngine Pblock.

You can use the Highlight Primitives tool to create a highlighted view.

Implemented Design - xc7k70tfhbge76-3 (active) b4

Metlist _ O wr = E Project Summary X | G Device X O =
= >i|E

4] top

-5 Nets (1022)

45 Primitives (153)

+E fftEngine
+E matEngine (I
-+l usbEngine0
+-[il| usbEngine 1 (usb
+-[d] whaArbEngine

£ Sources )] Netlist

Instance Properties — O X
+ %k
[El usbEngine0
MName: usbEngine0 i
Pk
Cell: usbEngine0#usbf_top E
Type: Others
Mumber of instance pins: 166
Number of nets: 166 é‘ iy b uEngine

General | Attributes | Statistics | Instance Pins | Chil ¢ p B

Figure 23: Implemented Design - usbEngine

1. To verify that timing has been met, review any of the following:
e The Timing Score in the Design Runs view
e The details of the Timing Results window
e The Timing Score in the Project Summary window

2. In the Flow Navigator, click Promote Partitions to promote the successful synthesis and
implementation results.
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3. If the Elaborated Design view is not opened, you are prompted to open it.

4. Select only the usbEngine0 and usbEnginel instances in both the synthesis and
implementation runs.

5. Set the Promote directories.
e synth 1: <Extract Dir>/Promote/usbEngine/synth 1
e impl 1: <Extract Dir>/Promote/usbEngine/impl 1

6. Uncheck Automatically manage Partition action and import location.

E Promote Partitions @

\", Please select entire runs or spedfic partitions to be promoted. This copies the partitions in implemented run to the spedfied promote
¥ directory. After promoting runs, you can import the partitions into runs.

Select Partitions to promote

= =
Run Directary Description
E synth_1 C:/Data/PlanAhead_Tutorial _TD/PromotefusbEngine fsynth_1 B
L top
[ cpuEngine

- ¥l usbEngine

[l usbEngine1

E| impl_1 C:/Data/PlanAhead_Tutorial_TD/Promote/usbEngine fimpl_1 E]
.l top

[ cpuEngine

vl usbEnginel

vl usbEngine1

] mn r O

Select Implemented H Clear all

[7] Automatically manage Partition action and impert location

Figure 24: Promote Settings for usbEngine0 and usbEnginel

7. Click OK to promote the usbEngine0 and usbEnginel partitions.

8. After the partitions have been promoted, you can close the current project.

Team Design Tutorial www.xilinx.com 33
UG839 (v14.5) April 25, 2013



v
i¢ X"—l NX Step 7: Running the Assembly as Team Lead

er

Step 7: Running the Assembly as Team Leader

In the previous steps, each team member synthesized, implemented, and promoted a version of
their block. The team leader can now assemble the design. The team leader:

Reopens the team leader project.

Sets up the partitions for import.

Setting Up the Team Leader Project To Do an Assembly Run

To set up the team leader project to do an assembly run:

1.

S T

Reopen the following project:

<Extract Dir>/Projects/project TL

This is the original project. It already contains:

e The defined team member partitions.

e The successful synthesis results for the top module.

e The Pblocks for the team member blocks.

Now, update the project to define the team member blocks as logic instead of black boxes.

To do this, add the netlists files (NGC) from the successful synthesis runs of each team
member’s promoted partition.

From the Project Manager, click Add Sources.

Select Add or Create Design Sources.

Click Next.

Select Add Files.

Add the following files:

e <Extract Dir>/Promote/usbEngine/synth 1/usbEngineO#usbf top.ngc
e <Extract Dir>/Promote/usbEngine/synth 1/usbEnginel#usbf top.ngc
e <Extract Dir>/Promote/cpuEngine/synth 1/cpuEngine#or1200 top.ngc
Click Finish.
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Add Sources @
Add or Create Design Sources
Spedify HOL and netlist files, or directories containing HOL and netlist files, to add to your project. Create a new source file on disk @

and add it to your project.

Id  MName Library  Location
B 1 cpuEngine #or 1200_top.ngc M/A C:\Data\PlanAhead_Tutorial_TDPromote'cpuEngine\synth_1
2 usbEngine0#usbf_top.ngc  M/A C:\Data\PlanAhead_Tutorial_TD\PromoteusbEngine\synth_1
i7:) usbEngine 1#usbf top.ngc  MNJA C:\Data'\Planahead_Tutorial_TD\PromoteusbEngine\synth_1

| Add Files... | [ Add Directories. .. ] [ Create File...

[ Scan and add RTL indude files into project
Copy sources into project

Add sources from subdirectories

Figure 25: Add Post Synthesis Results for Team Member Partitions

8. In the Flow Navigator, click Open Synthesized Design.

All partitions are now promoted and defined for this project. It is not necessary to rerun
synthesis. The latest synthesis results of all team members (including the team leader) are
used for this assembled design.

Ta
b

Metlist — O

= il |E]

5] top
[+ Nets (1022)
| Primitives (153)

4% Sources™, 3] Netlist

Figure 26: Synthesized Design with All Partitions Promoted
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Updating Partition Settings and Running the Assembly

To update partition settings and run the assembly:

1. In the Flow Navigator, click Specify Partitions and access the Implementation Partition
settings. The Synthesis tab can be left as is since synthesis is not being run again.

2. Leave the Top partition action as Implement.

3. Change the following remaining partition actions to Import:
e cpuEngine
e UusbEngine0
e usbEnginel

4. Change the Import from field to the location to which the team members promoted the
implementation results.

e cpuEngine: <Extract Dir>/Promote/cpuEngine/impl 1
e usbEngine0: <Extract Dir>/Promote/usbEngine/impl 1
e usbEnginel: <Extract Dir>/Promote/usbEngine/impl 1

Because both usbEngine instances were implemented together and promoted together, the
Import From location is also the same.

-

E Specify Partitions IEI

\'] Spedfy whether partitions will be imported or implemented

Synthesis~ Implementation

Name Action Import from Preservation

v top Implement = M/A

C:/Data/PlanAhead_Tutorial_TD/Promote /cpuEngine fimpl_1

[ usbEngined Impart  + | C:/Data/PlanAhead_Tutorial_TD/Promote/usbEngine impl_1
[#w usbEnginel Impart  w | C:/Data/PlanAhead_Tutorial_TD/Promote/usbEngine fimpl_1

[ oK ] [ Cancel
Figure 27: Partition Settings for Assembly Run
5. Click OK.
6. Click OK on the Reset out-of-date run dialog to reset impl_1.
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Note: To save time, instead of rerunning implementation on the current project, open the
completed project at: <Extract Dir>/Projects/project TL assembled. When the
project is open, from the Flow Navigator select Open Implemented Design.

7. Click Run Implementation in the Flow Navigator to launch implementation and assemble
the promoted partitions into the top-level design of the Team leader.

8. In the Implementation Completed dialog box, select Open Implemented Design.

There should be no Critical Messages or Undefined Modules Found dialog boxes. These
would be unexpected messages.

Verifying and Promoting Assembly Results

In this design:

e Each team member block is logically isolated from other team member blocks.
e All the boundaries are registered.

e The placement of each team member block was sufficient the first time through.

Implemented Design - xc7k70ttbg676-3 (active) b4

Metist — O @ = T Project Summary x| G Device x O =
= H|E

4] top

+-15 Nets (1022)
(=) Primitives (153]
+1-{d] dkgen (dock
[ cpuEngine (c
+-[4] fftEngine (ff
#-{H] mgtEngine (matTop)
+- Bl usbEngine0 (ush
+- Bl iisbEngine 1 [IsbER

+-[] wbArbEngine

- Properties

)

44 Sources 5] Netlist

Figure 28: Implemented Design View of the Assembled Design
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For more complex designs, this assembly run may be the first of many. The process described in
this tutorial may be repeated as necessary.

Each team member project can now start to import other team member blocks from this
promoted assembly run. This helps interface timing to converge early in the design cycle,
instead of leaving other team member blocks as black boxes and discovering interface timing
issues at the end of the design.

With the Implemented Design view open, you can see the entire design, as seen in Figure 27.
You can use the Highlight Primitives command to create this highlighted view.

Verifying That Timing Has Been Met

To verify that timing has been met, review any of the following:
e The Timing Score in the Design Runs view
e The details of the Timing Results window

e The Timing Score in the Project Summary window

Verifying That All Team Member Partitions Were Imported

To verify that all team member partitions were imported, review the Implemented Partition
section of the Project Summary view.

»

|:| Implemented Partitions

top cpuEngine
Type: Mormal Type: MNarmal
State: Implement State: Import
PAR. Preservation Level: Routing Import Location: [Promote fcpuEngine fimpl
Boundary Optimization: Mone PAR Preservation Level: Placement

Modified Import Logic:  Routing

Boundary Optimization: Mone

usbEngined usbEnginel
Type: Mormal Type: MNarmal
State: Import State: Import
Import Location: fPromote fusbEngine fimpl Import Location: {Promote fusbEngine fimpl
PAR Preservation Level: Placement PAR Preservation Level: Placement
Modified Import Logic:  Routing Modified Import Logic:  Routing
Boundary Optimization: Mone Boundary Optimization: Mone

Go to: Spedfy Partitions

Figure 29: Partition Summary Section of Project Summary
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Promoting Successful Synthesis and Implementation Results

Modifications to the design may require some or all of this flow to be repeated. Using these
successful assembly results in future iterations may be beneficial. To promote the successful

Step 7: Running the Assembly as Team Leader

synthesis and implementation results:

1. In the Flow Navigator, click Promote Partitions.

2. If the Elaborated Design view is not opened, you are prompted to open it. Click OK.
3. Select all partitions in both the synthesis and implementation to be promoted.

Because the placement of the Top partition meets all interface timing, each team member
can now begin to import Top, as well as other team member partitions to maintain this

interface timing in all future iterations.

4. Setthe Promote directories:

e synth 1: <Extract Dir>/Promote/top/synth 1

e impl 1: <Extract Dir>/Promote/top/impl 1

Note: Promote/top/synth 1 already exists from an earlier step, but you will need to add
impl 1 tothe Promote/top folder.

Please select entire runs or specific partitions to be

pramoted. This copies the partitions in implermented run to
the specified promote directory, After promoting runs, you can

import the partitions into runs.

Select Partitions to promote

=]
pig A

Run

|Directory Description

W synth_1  [romotestop/synth 1 |[-] ITL synth run

b top

b cpuEngine
b4 ushbEngined
L usbEnginel

M impl_1 || /Promoteitopfirmpl 1 ||:||TL impl run
[ top
¥ cpuEngine

[ usbEngined
L ¥ usbEnginel

| Select Implemented || Clear All |

[Jlautomatically manage Partition action and import location

Lok ||

Figure 30: Promote Settings for Assembled Design

For this tutorial, the synthesis results for the team leader have not changed from when they

were last promoted. However, the team leader might develop additional logic in the top

Team Design Tutorial
UG839 (v14.5) April 25, 2013

www.xilinx.com

39



& XILINX.

6.

level design in parallel with the other team members. Promoting synthesis and
implementation now ensures that all team members can work on the latest design.

Uncheck Automatically Manage Partition Action and Import Location.

Disabling Automatically Manage Partition Action and Import Location prevents the
software from automatically changing the import locations of the team member partitions to
the location to which they were just promoted (Promote/top).

Instead, the software maintains the locations defined in the previous steps. This simplifies
running the assembly step in future iterations.

Click OK.

Conclusion

In this tutorial, you did the following:

Used partitions and the Team Design methodology to synthesize and implement a design in
multiple parts.

Assembled the full design.
Synthesized and implemented blocks as black boxes.
Promoted successfully synthesized and implemented partitions to a central repository.

Created PlanAhead projects for each team member.
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